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Workspace 
AKVIS SmartMask is a plug-in to a photo editor.  

To call AKVIS SmartMask plugin, select the command Filter –> AKVIS –> SmartMask 
in Adobe Photoshop ; in Corel (Jasc) Paint Shop Pro it will be the menu item Effects 
–> Plugins -> AKVIS –> SmartMask; in Corel PHOTO-PAINT call the command Effects 
–> AKVIS –> SmartMask.  

Attention! Before you call the plug-in you must copy the image to a separate layer 
(Duplicate layer).  

The workspace of AKVIS SmartMask looks like that: (Fig. 1).  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 1. 
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Workspace Elements: 

In the upper part of the window there is a Control Panel with the following buttons:  

• The button  opens files with the .Smask extension. This file type contains information about the saved mask - the drawn strokes, 
color areas, the settings used. 

• The button  saves the resulting mask and all its settings in a separate file with the .Smask extention. 

•  The button Undo   cancels the last operation. It is possible to cancel several operations in a row. The hotkey for the command is 
Ctrl+Z (Command+Z on Macintosh).  

• The button Redo   returns the last cancelled operation. It is possible to return several operations in a row. The hotkey for the 
command is Ctrl+Y (Command+Y on Macintosh). 

• View Modes:  

o The view mode  shows the image in its original state. In this way you can compare the result with the original image. (Fig. 2). 

o The view mode  shows the result on a transparent background. It is the way you will see the cutout object in the photo editor. 
(Fig. 3).  

o The view mode  shows the cut object on a color background. By default the background is orange, but you can change the color 
at any time. For this purpose, click on the color plate that appears when you hover with the mouse over the button, and select a 
color from the Color Selection Dialog. (Fig. 4). 

o The view mode  shows all pixels with Opacity 100% as black points. White points are the pixels with Opacity 0%. The pixels 
having Opacity between 0% and 100% are shown as shades of gray. The darker the gray shade, the higher is the transparency of 
this point. (Fig. 5).  

o The view mode  shows all pixels with Opacity = 100% as black points. White points are the pixels with Opacity = 0%. Gray 
points are all other pixels (0% < Opacity < 100%). This mode is good for finding areas that seem to be deleted, but they are not. 
(Fig. 6).  
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Fig. 2. Original image Fig. 3. On transparent background Fig. 4. Image on a color background 

Fig. 5. Mask Fig.6. Find unselected areas 
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The image is shown in the Image Window according to the chosen view mode. 

• The button   turns on/off the drawn strokes. 

• The button  turns on/off the defined color areas, as well as adjusts their opacity. Use the pop-up control to adjust the Opacity of 
the color areas. 

• The button  starts image processing.  

• The button   applies the result, closes AKVIS SmartMask's window and the selected object appears in the workspace of your 
photo editor.  

• The button  calls information about the program.  

• The button  calls help files to the program.  

• The button  allows selecting the interface language. To change the interface language click on  with the left mouse button, 
then choose the language from the drop-down menu.  

• The button  allows closing the plug-in's window without applying the result. 

 

Navigate and scale the image using the Navigator Window. The red frame shows the part of the image that is now visible in the Image 
Window. 

 

 

 

 

 

 
 
 
 



Workspace 

 13 

Drag the red frame to view the required part of the image in the Image Window. To move the red frame, put the cursor inside the frame, 
press the left mouse button, and keeping it pressed, drag the frame.  

Besides, you can scroll the image in the Image Window by pressing the space bar on the keyboard and by dragging the image with the left 
mouse button. 

Use the buttons  and  , as well as the slider to scale the image in the Image Window. By clicking on  or by moving the slider to the 

right, you scale up the image; by clicking on  or by moving the slider to the left, you scale down the image in the Image Window. 

It is also possible to enter a new scale coefficient into the appropriate field and press the button Enter (Return on Macintosh).  

Besides, to scale the image you can use hot-keys: + and CTRL++ (Command++ on Macintosh) to scale up the image, -  and CTRL+- 
(Command+- on Macintosh) to scale down the image. 

  

Under the Navigator there is a Settings Panel with three tabs: Sharp, Soft and Complex. Every tab contains the settings for the 
corresponding mode. To select a tool on the Toolbar on the left from the Image Window, click on the corresponding icon with the left 
mouse button.  

Below the Settings Panel there is a Hint field: first time you launch the program it shows a short description of AKVIS SmartMask; as you 
work with the program it shows hints to the parameters of the chosen tool or the chosen mode. 
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Working with the plugin 
Follow this instruction to cut out an object using SmartMask: 

1. Open an image in your photo editor. 

2. Copy the image to a new layer (Duplicate Layer). 

3.  Call AKVIS SmartMask plugin. For this purpose select the command Filter > 
AKVIS > SmartMask in Adobe Photoshop ; in Corel (Jasc) Paint Shop Pro it 
will be the menu item Effects > Plugins -> AKVIS > SmartMask; in Corel 
PHOTO-PAINT call the command Effects > AKVIS > SmartMask. The plugin will 
open with the image loaded into the workspace. (Fig.1).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Fig.1. 
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4. Depending on the type of the object's edges, you can choose between three processing modes (Sharp, Soft and Complex) by clicking 
on the corresponding tab in the Settings panel. By default the plugin uses the Sharp mode.  

• Sharp mode. This mode suits for images with a good contrast level and for objects with sharp edges (buildings, clothes, 
machines...). 

  
 

 

• Soft mode. This mode is good for selecting objects with not clearly defined edges (hair, fluff, fur...). 

 

 

 

 

 

 

 

 

 

 

 

   

Original image Sharp mode 

Soft mode Original image 
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• Complex mode. This mode is especially good for selecting complex objects - transparent or glass objects, objects that have 
the same color range as the background (trees, dishware, soap bubble...). 

  
 

 

 

 

 

 

 

 

 

 

Hint:  For some images it is enough to use only one mode, for others you may need to use all three modes. 

Attention!  You can start working in any of these three modes, but to achieve a good result it is advisable to work consequently (for example, 
if you start working in the Complex mode and then try to switch to one of the preceding tabs, the changes will be cancelled and 
the image will be processed with the settings of the current tab). 

 

5. Cut out the required object in accordance with the instructions for the chosen mode.  

6. Before you apply the result and close the plugin, you can save the mask (the drawn strokes, color areas, and the settings) into a 

separate file. For this purpose, just click on . In the future you will be able to load the mask from the file (with the button  ) 
and edit it. 

7. Click on  to apply the result and close the plugin. The selected object will appear in the worspace of your photo editor.  

 

 

 

 

Original image 
 

Complex mode 
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Hot keys 
   

Ctrl+Z - this combination cancels the last operation;  

Ctrl+Y - this combination returns the last cancelled operation;  

V - this combination switches between the current and previous View mode;  

+ or Ctrl++ (Cmd++ on Macintosh) - increases the scale;  

- or Ctrl+- (Cmd+- on Macintosh)- reduces the scale;  

Ctrl+Enter (Cmd+Return on Macintosh) - this combination starts image processing;  

   

Tools:  

B - Pencils and brushes (draw the strokes in the Sharp and Soft modes and Magic brush in the Complex mode)  

E - Erazer (all modes);  

Z - Zoom (all modes);  

G - Bucket tool (in the Soft mode);  

I - Eyerdropper (in the Complex mode);  

Y - Restore brush (in the Complex mode);  

R - Blur brush (in the Complex mode).  

 

 

 

 

 

 

 



Working with Program: Sharp Mode 

 18 

Working with Program: Sharp Mode 

The Sharp mode suits for images with a good contrast level and for objects with sharp edges (buildings, clothes, machines...). (Fig. 1).   

To cut out an object in the Sharp mode: 

1. Use the following tools to define the areas that must be deleted and the areas that must be kept. (Fig. 2).    

• Keep Area Pencil . Use the blue pencil to outline the areas that should be kept.  

• Drop Area Pencil . Use the red pencil to outline the parts that should be deleted.  

Use the hot-key B on the keyboard to activate these tools and to switch between them.  

• Eraser . Use the tool to erase drawn strokes. Use the hot-key E to activate this tool from the keyboard.  

• Zoom ). Use this tool to scale the image. A left-click with the mouse increases the scale, a right-click with the mouse 
reduces the scale. If you move the cursor keeping the left button of the mouse pressed, a "running ants" frame appears. The 
fragment in the frame will be scaled to the size of the Image Window. Use the hot-key Z to activate this tool from the 
keyboard.  

The Brush Size of the Pencils and the Eraser tool can be adjusted on the Settings Panel.  

 

 

 

 

 

 

 

 

 

 

Fig.1. Fig.2. 
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2. Start processing the image by clicking on . The image will be processed with the 
default settings. The program will take into consideration the drawn outlines and generate 
three zone types: the areas that will be deleted are marked red (the points in this area 
have Transparency = 100%), the areas that will be kept are marked blue – (the points in 
his area have Transparency = 0%). Red and blue areas will have a green transition 
border. The points in the green border have different Transparency values (between 0 
and 100%), which accounts for the smooth edges of the selected (cutout) object. (Fig. 3). 

 

 

 

3. If you are not satisfied with the result (Fig. 4), edit the strokes and adjust the parameters in the Settings Panel:  

• Edge Priority. This parameter defines the way the points between the red and blue outlines are treated (undefined areas) and, 
thus, specifies the edges of the cut-out object. If you increase the value of the parameter, the edges of the cut-out object are 
defined as the border between the objects marked with different colors. If you reduce the value, the program will give priority to 
the color range of the undefined areas. The program will compare the colors of these points with those in the red/blue zones 
and color them accordingly to define the border. By default the value is set to 50 and the program considers both principles 
equally.  

• Find Similar Areas. By default the check-box is disabled. In this 
case the points of the image are colored in accordance with the 
strokes drawn in the nearby areas. When the check-box is 
enabled, the program will compare the color of the undefined 
points with the color range of the points in the red and blue zones 
(on the whole image) and mark them accordingly. It is helpful 
when you need to cut out inscriptions or a lattice.  

• Mask Smoothing. This parameter allows smoothing the edges of 
the cutout object . The higher the value of the parameter, the 
smoother are the edges of the object. 

• Sharpen Edges. This parameter sharpens the edges of the cutout 
image. The higher the value of the parameter, the sharper are the 
edges of the object.  

 

 

 

Fig.3. 

Fig.4. 
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4. Click on again to start processing the image (Fig. 5). 

5. If you are satisfied with the edges of the cutout object, click on to apply the 
result and close the plugin. The cutout image will appear in the workspace of your 
photo editor.  

If the edges are not clearly defined and the result is not achieved, edit the mask 
in other modes (Soft and Complex tabs).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.5. 



Working with Program: Soft Mode 

 21 

Working with Program: Soft Mode  
This mode is good for selecting objects with not clearly defined edges (hair, fluff, fur...). 
(Fig. 1). 

1. First use the Sharp mode to define color zones: (Fig. 2):  

Blue zones are the parts of the image that must be kept. The points in his area have 
Transparency = 0%.  

Red zones are the parts of the image that will be deleted. The points in this area have 
Transparency = 100%.  

Green zones are a "transition border" between the kept and cutout areas. The points in 
these zones have different Transparency values (between 0 and 100%).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.1. Original photo 
 

Fig.2. 
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2. Use the following tools to edit the color zones :  

To edit the blue zones, use and , for red zones - and , for green 

zones - and .  

Adjust the stroke width by changing the value of the Brush Size parameter on 
the Settings panel.  

Use the Green Zone Width parameter on the Settings panel to change the size 
of the green zones. The higher the value of the parameter, the wider is the green 
transition border. This parameter influences only on the automatically generated 
green zones and changes their size on their full length. To edit the green zones 
more precisely, use the corresponding pencils from the Toolbar. (Fig. 3).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Fig.3. 
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3. If needed, adjust the Sensitivity parameter on the Settings panel. This 
parameter influences on the amount of details revealed in difficult areas (Fig. 3).  
The higher the value of the parameter, the more semitransparent details are 
visible.  

4.  Start image processing by clicking on  . 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.4. 
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5. If you are satisfied with the result obtained in the Soft mode, click on to 
apply the changes and return to the photo editor. If the result needs some 
improvement, go to the Complex tab; in this mode you can touch up the 
selection. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

    Hint:  The result of the Soft mode often leaves much to be desired; it is rather a preliminary mode before manual processing in the 
Complex mode. Despite these drawbacks, the Soft mode saves you much time and minimizes manual work. 

 

 

Fig.5. Result 
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Working with Program: Complex Mode 
The Complex mode is especially good for selecting complex objects - transparent or glass objects, objects that have the same color range as 
the background (trees, dishware, soap bubble...) (Fig. 1).  

Attention!  It's a manual mode, therefore the button Run is disabledю 

1. Use the check-box Only in green zone to define the operation mode. When the check-box is enabled, only the areas within the earlier 
drawn green zone will be edited. When the check-box is disabled, the changes will influence on all points of the image.  

2. Edit the image manually using the following tools (Fig. 2):  

• Drop Colors ( ). The colors chosen with this tool are listed in the Drop Colors field. To select a color, click on the 
corresponding image point with the left-button of the mouse.  

• Keep Colors ( ). The colors chosen with this eyedropper are listed in the Keep Colors field. To select a color, click on the 
corresponding image point with the left-button of the mouse.  

Use the hot-key I on the keyboard to activate these tools and to switch between them.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 1. 

Fig. 2. 
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The Drop Colors and Keep Colors fields are found on the Settings panel. They contain color sets chosen by the user. Add colors 

using the above-mentioned tools. It is posible to group colors. To create a new group, click on the button . To delete a color from 

the list, select this color with a left-click of the mouse and press the button . The green check mark defines the colors/groups of 
colors that will be taken into consideration when calculating the result.  

3. Process the image using the Magic Brush tool ( ).  

The Magic Brush keeps the points having the colors listed in the Keep Colors field and deletes the points having the colors listed in 
the Drop Colors field. Other colors are kept or deleted according to their closeness to one or another color set. (Fig. 4).    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.3. on trasparent background 
 

Fig.4. on color background 
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Magic Brush has the following parameters:  

There are three check-boxes that define the operation mode of Magic Brush:  

Calculate. When the check-box is enabled, the brush removes the points having the same colors as those listed in the Drop 
Colors field and colors close to them, and it restores the points having the same colors as those listed in the Keep Colors field 
and colors close to them.  

Repair. In this mode the Magic Brush restores only the points having the same colors as listed in the Keep Colors field.  

Clean. In this mode the Magic Brush deletes only the points having the same colors as listed in the Drop Colors field.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

Check-box Repair enabled Check-box Clean enabled 

Before application of the tool 
 

Check-box Calculate enabled 
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Parameters that set the zone of effect application:  

Brush. This parameter sets the inner diameter of the brush, that is the zone where the chosen effect is applied to the full.  

Edge. This parameter sets the outer diameter of the brush, that is the zone where the chosen effect is applied partially.  

Check-box Foreground Recovery. In most cases the objects on a photo are not evenly lighted, therefore the cutout object can have 
shades and colors reflected from the nearby objects. Such color shades can be absolutely inappropriate on a new background: for 
example, hair having a blue cast from the sky or a green shade from the trees, shadows of objects on the clothes... The check-box 
Foreground Recovery helps to get rid of the unwanted color shades. Just select a color with a click on the color plate (use the 
Standard Color Selection Dialog or use the eyedropper tool to pick a color from the image); or set Opacity (with a right click) - in 
this way you select a color from the Keep Colors list. Process the image with the Magic Brush - the colors will get the chosen shade. 
The Strength parameter defines the influence of the applied color. The higher the value of the parameter, the more the colors are 
subject to change.  

 

 

 

 

 

 

 

 

 

 

 

 

Sensitivity parameters:  

Brush. The parameter influences on the amount of details recovered in difficult zones. The higher the value of the parameter, 
the more semitransparent details are visible.  

Sensitivity to Keep Colors. The higher the value of the parameter, the wider is the range of the colors kept on the image.  

Sensitivity to Drop Colors. The higher the value of the parameter, the wider is the range of the deleted colors.  

 

Check-box Foreground Recovery 
is disabled 

 

Check-box Foreground Recovery 
is enabled 
green color selected 
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4. Repeat steps 2 and 3 changing color sets till the whole image is processed.  

5. Touch up the result using the following tools :  

• Restore Brush  . This tool restores the area to its original state. Use the hot-key Y to activate this tool from the keyboard.  

   

 

• Eraser . This tool erases the areas to which it is applied. Use the hot-key E to activate this tool from the keyboard. 

 

 

 

 

 

 

 

 

 

 

 Before application of the tool 

 Before application of the tool 
 

 After application of the tool 
 

 After application of the tool 
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• Blur  . This tool creates a blur effect by reducing the color contrast between the adjacent pixels. The tool is characterized by 
the Blurring parameter. The higher the value of the parameter, the stronger is the effect. At Blurring= 1 there is no blurring at 
all. Use the hot-key R to activate this tool from the keyboard.  

For all these three tools you can adjust the Brush and Edge parameters. 

6. Click on   to apply the changes and quit the plugin. 
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